




WELCOME TO THE FLUX COMMUNITY!

FLUX started with a passion for digital creation and making 

easy-to-use and affordable tools for makers and designers. 2,500 

backers helped us successfully raise $1.6M on Kickstarter for 

our first modular 3D printer, FLUX Delta, back in 2014. Having 

received numerous requests from our users for a more accessible 

laser cutter, we decided to take on this challenge and dove into 

the world of laser technology. In the last couple of months we 

have worked hard for this moment and put a lot of heart and soul 

into development and production.

We proudly present beamo, the laser cutter that will help you 

create things that you'll love, and have fun during the process, 

too. With the hashtag #madewithbeamo, you will find inspiration 

from other members of the FLUX Community. Please share your 

creations online with us, we can't wait to see how you will use 

your beamo and all the amazing things you will make!

In pursuit of the same goal we’ve had since day one, we work 

closely with our users. So please do not hesitate to contact us, 

we are looking forward to your feedback. You can always reach 

us at support@flux3dp.com. 

Enjoy! 

Team FLUX
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1.1 USING THIS USER MANUAL

These operating instructions must be carefully read and 

observed before using beamo for the first time. Non-observance 

of individually listed points in the instructions can cause personal 

injury and/or property damage.

No part of this manual may be reproduced, edited or modified 

in any form without the prior consent of FLUX Inc.. The rights 

for reproduction in any form are reserved. FLUX Inc. reserves 

the right to change specifications of the hardware and software 

described in the user manual at any time and without prior 

notice.

The following symbols are used to facilitate the understanding of 

this manual:

Warning: This area represents a special danger for the user or the 

person responsible for maintenance if the operating instructions 

are not observed.

Warning: In these areas, pay particular attention to the possible 

dangers of laser light.

Additional accessories must be compatible with the base unit, if 

you have any questions, please contact FLUX Support:  

support@flux3dp.com.
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1.2 CO2 LASER BASICS
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1.3 SAFETY & CONFORMITY

Be sure to read the following safety precautions carefully before 

starting to operate beamo. beamo uses a high-power laser 

beam. Improper handling can result in fire, visual impairment, 

skin burns, or inhalation of toxic substances, and other personal 

safety hazards.

   

                                   Important Precautions

1. Never leave the machine unattended while operating.

2. Be sure to have a fire extinguisher in the work area.

3. Do not try to service, repair, or modify the machine 

without authorization from FLUX Support.

4. Do not stare at the flame generated by the laser.

5. Please make sure that the processed material does not 

pose a hazard when burned at high temperatures.

 

User Safety

1. All personnel who will operate the machine shoud read the 

safety precautions and follow the instructions. Confirm with 

FLUX Support if you have any questions regarding use and 

safety: support@flux3dp.com. 

2. Children require the supervision and assistance of an adult at 

all times. 
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3. Operating environment: 

a. Place the machine in a well-ventilated area.

b. Avoid rain, moisture, liquids, or direct sunlight.

c. The ambient temperature should be 5°C - 35°C (41°F - 

95°F), and humidity should be 10% - 75%.

d. If venting outdoors, make sure that changing conditions 

do not cause extreme temperatures or humidity to affect 

the machine through the exhaust duct. Disconnect the 

duct from the outside air when the machine is not in use.

e. Place the machine on a stable surface to prevent it from 

moving or overturning.

Electrical Safety

1. The machine comes in 2 versions, 110V and 220V. Do not use 

a power source other than the AC rated voltage. If in doubt, 

contact FLUX Support. (110V: 100 - 127V / 220V: 200 - 240V)

2. Make sure that the grounding pin is properly connected. If 

not grounded properly, static electricity might be generated 

that could affect performance and even increase the risk of 

electric shock.

3. Do not use the power cord if it is damaged.

4. When maintaining or disassembling the machine with the 

consent of FLUX Support, be sure to turn the power off and 

unplug the unit.
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Fire Safety

1. Do not put anything inside the machine that is not laser-

compatible. See about laser-compatible materials (p.0000).

2. Do not stack materials or attempt to cut two or more sheets 

of material at a time.

3. Clean out leftover debris inside the unit when it builds up.

4. Never leave the unit unattended while operating; always 

keep it within sight. Look inside frequently.

5. If there is a lasting flame inside the unit that does not 

extinguish after the laser has moved:

a. Turn off the machine and unplug on the back of the unit.

b. If it is safe to do so, extinguish the fire with a wet towel. 

Note that water may damage the machine.

c. Alternatively, extinguish the fire with a fire extinguisher. 

Note that fire extinguishers may damage the machine.

d. If the fire cannot be extinguished or if it spreads outside 

the machine, call your local emergency number. 

Smoke and Fume Safety

1. When exhausting outdoors, be sure that the exhaust location 

won’t be bothersome to neighbors or passers-by, and don’t 

forget to check local air quality regulations that may apply.

2. If a strong, sharp smell -- that also causes eyes, nose, or 

throat irritation -- is detected, or visible smoke is escaping 
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the machine while the lid is closed, stop immediately and re-

check your exhaust setup. 

Operation Safety

1. Do not stare at the flame generated by the laser.

2. Stabilize the unit to prevent it from moving or overturning.

3. In case of burn injury, seek medical advice. 

4. Wear gloves when cleaning leftover debris. 

5. Have two people lift the unit when moving the machine.

       Stop using your beamo if...

1. There is a fire in the unit which persists after the laser 

turns off.

2. The head stops moving but the laser is on.

3. An unusual sound or light is coming from the unit.

4. You see any damage to the interior components of the 

unit. 

Conformity

The beamo unit is a Class 1 laser product containing an embed-

ded Class 4 CO2 laser. Because the Class 4 laser is fully con-

tained in a Class 1 enclosure, this laser product is designated as 

a Class 1 laser product during all procedures of operation.
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2.1 WHAT’S IN THE BOX

1. Place the box on the floor and open it. 

 

 

 

 

 

 

 

 

2. Remove the packing foam ion the four corners and take the 

machine out of the box. Have two people lift it out of the 

box. Keep the packaging in case you need to transport the 

machine in the future.
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3. Open the lid and take out the vent hose, then take out the 

Accessory Kit. 

 

 

 

 

 

 

 

 

4. Content of the Accessory Kit: : ① Wi-Fi dongle  ② lubricant 

③ duct clamp  ④ double-sided tape  ⑤ power cord  ⑥ small 

wrenches  ⑦ hex key  ⑧ funnel  ⑨ sample material 
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5. Front view: ① laser head  ② focus bar  ③ honeycomb plate 

④ touchscreen  ⑤ power button  ⑥ transparent lid 

 

 

 

 

 

 

 

 

 

6. Rear view: ① USB ports  ② Ethernet port  ③ power 

connector  ④ exhaust fan 

 

⑥

④

⑤①

② ③
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2.2 ASSEMBLY

1. Connect the power cable.

2. Plug the Wi-Fi dongle into one of the two USB ports in the 

back of the machine. Turn the antenna upwards 90° for a better 

connection. 

 

 

 

 

 

 

3. Use the duct provided. Slide the duct clamp around the bigger 

end of the duct then install the duct and clamp over the fan 

exhaust on the back of your beamo. Use the small wrench to 

tighten the clamp. 
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2.3 NETWORK SETUP 

1. Press the power button to turn the machine on. It takes about 

1 minute to start up.

2. On the touchscreen, tap on Settings > Internet > Settings 

then select a Wi-Fi network and enter its password.

3. An IP address indicates the machine is connected. Restart the 

machine when network setup is done. 
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2.4 SOFTWARE DOWNLOAD & SETUP 

1. Download the latest version of “Beam Studio -- Stable” from 

the download section on the official FLUX website:  

https://flux3dp.com/downloads/ 

 

 

Windows: To check what version you need to download, 

right-click on the “This PC” icon > Properties and find 

“System type”. Download the x86 version for 32-bit systems 

and x64 version for 64-bit systems.

MacOS: Download and open the DMG file, drag the Beam 

Studio app into the Application folder next to it. Run the 

Beam Studio in the “Application” folder. 

2. A language dialog will appear when running Beam Studio for 

the first time. Select English > FLUX beamo.

 

Troubleshooting: Software Quits Unexpectedly (p.93)
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3. Fill in your beamo’s IP address in the text box and click Start

4. Go to menu > Machine or click on the camera icon at the 

bottom left corner to check if your beamo’s  name can be 

found. 

 

If you accidentally skip this dialog, click menu > Machine >  

Machine Setup 

Start your first task!
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2.5 FIRST TASK 

1. Adjusting Focus 

Place a workpiece in the machine. Rotate the focus bar 

downward until it is vertical. Loosen the laser head focus 

ring and lower the laser head until the focus bar rests on the 

workpiece. Tighten the laser head focus ring, and rotate the 

focus bar upwards until it is horizontal. 

 

 

 

 

 
 

                     ▲ loosen the laser head focus ring 

 

 

 

 

 

            ▲ the focus bar should rest on the workpiece

The focus must be adjusted each time the material is changed. 
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2. Camera Preview 

In Beam Studio, click on the camera icon ( ) at the bottom 

left and select your machine from the list. The preview mode 

is ready when the mouse cursor becomes a camera ( ).Click 

and drag your mouse cursor to preview the work area. Click 

on  again or press ESC to exit preview mode. 

 

 

 

 

 

 

 

 

 

 

If the preview result is not accurate, click menu > Machine > 

choose Machine > Calibrate Camera to run camera calibration. 

Compare the red-dotted-line square with the actual square 

engraved, manually adjust values to overlap the 2 squares. 
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2. Import Test File 

Click on menu > File > Samples > Example of beamo.  

 

 

 

 

Place the image at the ideal spot.  

 

 

 

 

 

 

 

 

Click on Export, select your machine from the list, and click 

Start to start the task. 
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3. Test Result 

 

 

 

 

 

 

 

 

 

If the result is too light or blurry, please check if the focus is 

just right. If the focus is right but the result is poor, please re-

check the optical path. See “Optical Path Adjustment” (p.58). 

If the position of the result varies with the camera preview, 

please recheck the focus or see “Camera Alignment Issue” 

(p.88).
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3.1 SOFTWARE USER INTERFACE

     

 

 

 

A. Object Placement 

       : Zoom in and zoom out

      : Group multiple items together

      : Ungroup items

      : Align multiple items horizontally

      : Align multiple items vertically

      : Distribute selected items horizontally between the left and  

        right borders

      : Distribute all selected items vertically between the top and  

         bottom borders

      : Traces the outline of all objects as if they were a single,   

         merged object

      : Subtracts the frontmost objects from the backmost object

Ⓐ

Ⓑ

Ⓒ

Ⓓ
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       : Traces the outline of the region overlapped by all the   

        objects

      : Traces all nonoverlapping areas of the objects, and makes  

        overlapping areas transparent

       : Reflect an object across a horizontal axis

       : Reflect an object across a vertical axis

       : Export the laser job to your beamo

B. Object Editing

       : Selection tool

       : Import JPG/PNG/SVG/DXF files. You can alsodrag the file  

         into the software

       : Type tool

       : Rectangle tool

       : Oval tool

       : Polygon tool

       : Pen tool

       : Copy selected objects into a rectangular array

        : Enable / disable camera preview
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C. Layer Management 

       ：Create and name a new layer

      : Delete selected layer

       ：Rename selected layer

       ：Sequence arrangement, the working sequence will be from  

         top to bottom

 
D. Power and Speed Setting

Parameters for commonly used mater ia l  can be found in the 

"Parameters…" drop down list. Customized parameters can be set 

using "Save". Use "Manage" to edit or remove saved parameters. 

Power is set by percentage which means a 30W machine can 

output 30W if the power setting is 100%. Speed is set by mm per 

second. Execution count can be set to repeat the same action on a 

single layer.

Pa ramete r s  may  va ry  w i th  d i f f e ren t  mate r i a l s .  Tr y  bu i l t - i n 

parameters on first run and then fine tune the parameters for 

better results.

The power setting is recommended to not exceed 70% to avoid 

drastic consumption of laser tube.
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3.2 TOUCHSCREEN USER INTERFACE

             Home                                               Connected to Wi-Fi

     

     Access previous laser jobs

    

    
           Hardware maintenance                   Activate Smart Trace 

  Online database           Machine settings                         
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3.3 BITMAP ENGRAVING

Bitmap and vector are two different types of digital image files. 

Bitmap is an image type that consist of numerous square pixels. 

Bitmap f i les are r ich in detai ls  which are most ly suitable for 

photography or digital applications. However, the quality is related 

to the resolution so the image can get jagged or blurry when 

resized. JPG and PNG are two commonly used bitmap format 

which are both compatible with Beam Studio.

Engraving Resolution

The Engraving resolution can be set in Beam Studio by menu > 

Edit > Document Setting .  Engraving resolution stands for the 

f ineness and quality of the result.  You wil l  get more detai led 

results when the resolution is set to "High", "Low" means shorter 

working times while getting a rougher quality. The quality stands 

for the spacing of each line scanned by the laser which correspond 

to 0.2mm /125 dpi, 0.1mm/250 dpi and 0.05mm/500 dpi. 

Threshold

The exposure threshold value can be set when a bitmap image file 

is imported to Beam Studio. Find the "Shading" and "Threshold" 

option in the "Laser Config" label. When "Shading" is disabled, 

images will be transformed into monochromic, which is optimized 

for built-in "Monochromatic Engraving" parameters. When "Shading" 

is enabled, images wil l  be transformed into greyscale,  which is 
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optimized for built-in "Monochromatic Engraving" parameters. 

When "Shading" is enabled, images wil l  be transformed into 

greyscale, which is optimized for built-in "Shading Engraving" 

parameters.

The "Threshold" va lue can be ad justed when “Shading” i s 

disabled. This function is based on the RGB color model which 

defines colors from 1 to 255. 1 stands for black and 255 stands for 

white. For example, setting the threshold value to 125 will turn all 

colors above 125 into white.

3.4 VECTOR ENGRAVING

A vector image is composed of paths defined by multiple points. 

Each path, curve or polygon is constructed with its own formula 

which means the quality will not be affected when resizing the 

image.  Vector  images are  espec ia l ly  su i table  for  logos and 

typesetting materials. Beam studio is compatible with SVG and 

DXF vector formats. 

Layers is a good way to manage a complex artwork when creating 

a vector image. Take Adobe Illustrator for example, the design can 

be organized by either different color groups or different layers. 

Beam Studio can read the layer setting so different engraving 

parameters can be set for each layer. Cutting and engraving can 

be processed in the same time by this method.
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3.5 COMPARISON BETWEEN BITMAP  
      AND VECTOR FORMAT

     

 

Select vector format for all cutting jobs.

3.6 LAYER SETTING

You can set the layering style by "Layer", "Color" or "Single 

Layer" when importing a SVG file. 

Layer: The layers will be categorized according to previous  layer  

 settings

Color: The layers will be categorized according to its color

Single Layer: Merge all layers into one single layer

3.7 SAVE SCENE

The "Save Scene" function can save all the items on the scene and 

keep them editable. This is useful when the design needs some 

editing but most of the scene should remain the same. Find this 

function in menu > File > Save Scene.

Bitmap Vector

Format JPG / PNG SVG / DXF

Usage infill engraving 
(monochrome/shading)

outline engraving/
cutting
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3.8 RECOMMENDED DESIGN SOFTWARE

AutoCAD is a CAD software specialized in accurate dimensions, 

so l ids  and more.  Su i tab le  for  a rch i tecture  and engineer ing 

applications. AutoCAD can export DXF format which is compatible 

with Beam Studio. If the dimensions do not match with the original 

design when imported, draw a 100mm square in Autocad then 

import it into Beam Studio to calculate the correct DPI.

Adobe Il lustrator is a vector graphic design software which is 

suitable for publishing, website and other applications. Illustrator 

can export SVG format which is compatible with Beam Studio. 

Please select the SVG 1.0 format when exporting SVG files. Choose 

"Outline" for texts, "embed" for images. 

Inkscape is a free and open source vector graphic design software. 

Its functions are similar to Illustrator. Inkscape can export SVG, 

JPG and PNG format which is compatible to Beam Studio. Please 

select "plain SVG” format when exporting SVG format.
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3.9 SMART TRACE

Smart Trace uses the onboard camera to scan and trace the 

outline of simple patterns. The process is quite simple, first you 

draw something on paper and the camera in beamo will convert 

your drawing to a digital file, you can then print the file on the 

materials of your choice. This feature can also be found on our 

app, BeamCam.  

1. Place the artwork in the work area.  

 

 

 

 

 

 

2. Use camera preview to take snapshots of the artwork.
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3. Click "Trace Image" and drag a square around the artwork 

that you want to trace. You’ll see a preview of what your 

beamo will engrave. Anything in black will be engraved, and 

nothing else will be. 

 

 

 

 

 

 

 

 

4. Darken or remove small details like dirt and noise by 

adjusting the exposure threshold value. 



39

5. Click "Preview" and when your trace looks ready, click 

"Apply". 

 

 

 

 

 

 

 

 

6. Set the power and speed and start the laser job. Prepare to 

see your newly digitized artwork!



40



41

4.1 TESTING NEW MATERIALS

To test different speed and power combinations on a new 

material, import the "Material Testing Suite" from the 

menu > File > Samples.
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4.2 WOOD

Types of Wood

• Medium-density Fiberboard (MDF) 

MDF is a made by wood fibers and resin binder 

formed under high temperature and pressure. Low 

formaldehyde MDF is recommended to reduce harmful 

fumes. 

• Plywood 

Plywood is made by layers of wood veneer or wood 

fiber glued together. Low formaldehyde plywood is 

recommended to reduce harmful fumes.

• Solid Wood 

Solid wood might have uneven grain when engraved 

due to growth rings. The uneven density of wood can 

cause such result which is very usual. 

Engraving Results on Wood

The slower the speed, the darker the engraved result. 

The higher the power, the deeper the cutting depth. 

To achieve a darker effect, slowing down the speed is 

usually more useful than increasing the power.
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How To Prevent Burn Marks On Wood

Cover the surface with masking tape prior to processing 

or remove the marks with sandpaper. The alternative is to 

damp the wood, but it might cause bumps on the surface.

How To Reduce Burn Edge On Wood

Clean the edges with alcohol or soapy water, or choose 

wood with lower density, so the cutting speed can be 

faster, leaving lighter edge marks. 

4.3 LEATHER

Types of Leather

• Synthetic Leather 

The surface of the synthetic leather is mainly divided 

into two kinds: PU (polyurethane) or PVC (polyvinyl 

chloride). PVC is strongly not recommended for laser 

processing (see Dangerous Materials). When PU is 

not completely burned, hydrogen cyanide might be 

produced. 

• Genuine Leather 

In general, to increase the thickness and durability, 

the leather will be processed by tanning. The tanned 

layer will require a slower speed when cutting.
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How To Prevent Burn Marks On Leather

Leather gets burnt and curled easily when processed by 

laser. Soaking the entire piece of leather in water before 

processing should help.

Ventilation Requirements for Leather

There are many amino groups and benzene rings in the 

leather protein composition, so nitrogen oxides or aromatic 

compounds may be produced during combustion. If the 

leather is engraved or cut for a long time, the ventilation 

requirements should be much higher than wood or acrylic. 

It is recommended to use an air filter.

4.4 ACRYLIC

Identifying Acrylic

Also known as PMMA or plexiglass, the scientific name is 

polymethyl methacrylate. It is one of the few plastics that 

can be processed by laser. It is important to distinguish 

whether it's acrylic or other plastic materials that are 

not suitable for laser processing (i.e. PVC or PC). When 

processed on, the edges of the acrylic are sharp and clear. 

If you see yellowish burn marks, the material is not acrylic. 

However, no burn marks doesn’t indicate that it is acrylic.
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Scratches on Acrylic

Scratches can be removed with plastic polish.

How to Clean Cloudy Acrylic

I t  is recommended that the f i lm should remain on the 

acry l ic  when process ing,  un less  engrav ing greysca le 

images. You can use an alcohol swab to clean the acrylic. 

Note that too much may cause other surface defects.

4.5 PAPER

How to Reduce Burn Edge on Paper

When cutting paper, it is easy to produce yellowish 

carbonized burn edges. The use of universal clay or other 

low-viscosity substances can effectively remove the toner 

to a certain extent without damaging the surface of the 

paper.

Corrugated Cardboard 

When cutting corrugated paper, the cardboard might catch 

on fire due to the misfocus on the downward layer. Spray 

the board with water to reduce the chance of burning.
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4.6 GLASS

Glass cracks easily so the laser power should not be too 

powerful. Choose thicker glass for better versatility.

4.7 METAL

Anodized Aluminum

Anodic treatment is a surface treatment that forms 

an oxide layer on the aluminum alloy. Through laser 

engraving, the surface oxide layer will be decomposed.

Stainless Steel (with coating or Hybrid Laser)

Stainless steel reflects most of the energy from a CO2 laser 

due to its wavelength. Special oxidants are required to 

allow the stainless steel to oxidize and darken at relatively 

low temperatures. Wear work gloves when applying the 

coating. If you're using the Hybrid Laser add-on, the laser 

can engrave on stainless steel directly.

4.8 OTHER SAFE MATERIALS

Stone, cement, EVA foam, cotton, linen material, etc.
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4.9 DANGEROUS MATERIALS

• PVC 

A material that shouldn't be laser processed. When 

burned, it produces HCl (hydrochloric acid gas) that 

harm the lungs and corrode machine parts. When 

burned, PVC also produces highly carcinogens such 

as dioxin or polychlorinated biphenyls. PVC is often 

presented as sticker, film or transparent sheet. 

• ABS 

A material that shouldn't be laser processed. It burns 

“dirty”, producing A (acrylonitrile), B (butadiene), 

and S (styrene), which are carcinogens category 2B, 1 

and 2B. 

• Plastics With Chlorine, Benzene, Ammonia, Fluorine, 

Phenol, Aldehyde or With Hexagonal Benzene Ring 

in its Molecular Formula 

When burning plastic molecules with these elements 

or organic structures, the chances of producing 

carcinogens and toxic substances are extremely high. 

Laser processing is not recommended.

     There should be no benzene ring in the

     molecule for the material to be laser-safe ▶ 
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5.1 INSIPIRATIONS         

              https://pse.is/KFDPQ

• Pinterest Idea Board https://pse.is/JXRR5

Search for "laser engraving" on Pinterest for more ideas! 

• Ponoko Laser Engraving Ideas https://pse.is/HQARL

5.2 VECTOR FILES

• The Noun Projects https://thenounproject.com/

• Freepik http://freepik.com/

5.3 CUTTING FILES

• DXF Projects https://dxfprojects.com/

• Canon Creative Park http://cp.c-ij.com/sc/index.html

• Paper-replika http://paper-replika.com/

5.4 FREE FONTS

• Dafont https://www.dafont.com/

To find conjoined words, check the category of calligraphy.
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6.1 KEEP EVERYTHING LUBRICATED

Clean and lubricate the guiding rods and rail periodically 

can extend the lifetime of the moving parts. The frequency 

recommended is once every 1 - 2 weeks.

1. Wipe away the oil grease on the guiding rodsand rail 

using a paper towel.

2. Apply lubricant on the guiding rods of the Y axis.

3. Apply lubricant on the top and side of the linear rail 

of the X axis.

4. Move the laser head up-and-down, left-and-right 

several times to evenly distribute the lubricant.

          



52

6.2 CLEANING OF THE WORKAREA 
 

Remove leftover cutting and engraving bits from the 

workarea whenever there is a buildup. A buildup of 

leftover bits can create a fire hazard.

1. Remove the honeycomb plate by first moving 

the laser head to the top left corner and lift the 

honeycomb plate slightly and slide it toward you. 

 

 

 

 

 

Mind the sharpness of the plate surface to avoid injury. 

2. Use vacuum cleaner or brush to clean the leftovers 

bits under the plate. Detergent can be applied to 

remove the stains

3. Return the plate to the original location, sliding it in 

horizontally. Be careful not to contact the laser head 

or the rails.
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6.3 WIPING THE LENS 
 

After every 40 hours of working, use lens wipes or wet 

cotton swabs to clean the lens and mirrors. Do not rub 

the mirrors fiercely to prevent damaging the coating on 

the mirrors. This will keep the unit working properly and 

prevent permanent damage to your unit.

 

 

 

 

 

 

1. Clean the three reflecting mirrors. 
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2. The focus lens is inside the lens holder under the 

third reflecting mirror. Remove the honeycomb plate 

to make room for the next step. Rotate the lens 

holder ring clockwise to release and remove the lens 

holder. 

 

 

 

 

 

 

 

 

                 ▲ release and remove the lens holder 

Rotate the silver ring on the lens holder counter-

clockwise to take out the focus lens. Use pliers if the 

ring is too tight to rotate.  
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6.4 WATER COOLER MAINTENANCE
 

Adding Water

When you see a low water level or a "#900 Cooler Off"  

dialog appears on the touchscreen. Please add water to 

the water tank. 

1. Unplug the machine.

2. Remove the back lid by unscrewing the 6 star screws 

with the hex key in the Accessory Kit. 

 

 

 

 

 

 

3. Open the water tank with the small wrench.  
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4. Fill up the tank using distilled water. Watch the water 

level carefully to prevent from spilling over. Seal the 

tank when the water level reaches 80% full.  

 

 

 

 

 

 

 

Changing Water 

It is recommended that the water should be changed once 

every 3 months.

1. Repeat Step 1 and 2 of "Adding Water". 

2. Remove the hose clamp with pliers and pull apart the 

hose from the white connector of the flow sensor. 

Place the two ends of the hose into a container to 

prevent water from spilling out. 

 

 

 

 

 



57

3. Remove the laser head, plug the air outlet into the 

water pipe. Go to touchscreen and press Action > 

Air Pump, the water will be blown out from the other 

end. Press "Air Pump" again when water is drained 

from the water tank and hose. 

 

 

 

 

 

 

 

 

4. Repeat Step 3 and 4 of "Adding Water".

5. Restart the machine. Go to touchscreen and press 

Action > Air Pump. The water in the tank will be 

pushed into the cooling system. Repeat Step 4 until 

the wate level no longer decreases.

 

Excessive bubbles in the laser tube may decrease the 

cooling efficiency. It is recommended to fill the water 

tank more than 80% to decrease bubble generation. 

 



58

6.5 OPTICAL PATH ALIGNMENT
 

If the workpiece cannot be cut through by the preset 

parameters or the beam output varies significantly on each 

corner of the work area, the optical path might be misaligned 

and needs adjustment. 

 

Tools

Accesory Kit: ② hex key ③ small wrench ④ tape

Prepare On Your Own: ① 2.5mm Allen key 

 

 

 

 

 

 

 

 

Safety Precautions

1. Keep the lid shut when pressing "Laser Pulse".

2. If you hear a loud cracking sound, stop operating 

and shut down the power immediately. Contact FLUX 

Support.  
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Remove the back lid by unscrewing the 6 star screws with 

the hex key in the Accessory Kit.

There are three sets of reflecting mirrors and one set of 

focusing lens in beamo. 

 

 

 

 

 

 

 

• First reflecting mirror is located on the left side of the 

laser tube.

• Second reflecting mirror is located on the carriage of 

the guiding rod on the left side.

• Third reflecting mirror is located on the rai l  of the 

X-axis.
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• Focusing lens is located inside the lens holder 

underneath the third mirror.

First Reflecting Mirror

Goal: Make the 2 dots shot from the top-left and the   

 bottom-left overlap.

1. Go to touchscreen > Maintain, the laser head will go 

back to home position. Then press "Release Motors".

2. Put a piece of tape over the second reflecting mirror. 

 

 

 

 

 

 

 

 

3. Move the laser head to the top-left positon manually. 

Close the lid and press "Laser Pulse".

4. Open the door and check the position of the dot. 

This dot is the reference point for adjustment. The 

shots made on other positions should be adjusted to 

move toward the reference point. 
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5. Manually move the laser head to the bottom-left.

6. Close the lid and press "Laser Pulse".

7. Open the door and check if the second beam is 

overlapping with the first one. If not, adjust the 

screws behind the first mirror. 

 

 

 

 

 

 

 

If the dot shot from the bottom-left is not found on the 

tape, the optical path is very much mis-aligned. Try the 

mid-left position instead of the bottom-left position. Make 



62

反射鏡 光點
         first mirror                 dot direction

sure the dots of the top-left and the mid-left overlaps, then 

try the original top-left and bottom-left adjustment.

8. The screws behind the first mirror control the mirror 

angle shown in the picture below. Release the nut on 

the screw, rotate the screw for the desired direction 

and test the dot position until the two dot overlaps. 

Tighten the nut back when the adjustment is done. 

 

 

 

 

 

 

 

Adjustment guide for the screws of the mirror: 

Shots made on the reference point (top-left in this 

case) rarely moves when adjusting the screws. So try to 

adjust the shot on the adjustable point (bottom-left in 

this case) by the screws and move the point toward the 

reference point until they overlap. 
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Second Reflecting Mirror

Goal: Make the 2 dots shot from the middle-left and the 

middle-right overlap.

1. Put a piece of tape on the metal ring of the third mirror. 

 

 

 

 

 

 

 

2. Move the laser head to the mid-left positon manually. 

Close the lid and press "Laser Pulse".

3. Open the door and check the position of the dot. 

This dot is the reference point for adjustment. The 

shots made on other positions should be adjusted to 

move toward the reference point. 
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4. Move the laser head to the middle-right position  

manually. Close the lid and press "Laser Pulse".

5. Open the lid and check if the second dot overlaps 

with the first one. If not, adjust the screws behind the 

second mirror.  

 

 

 

 

 

 

 

 

If the dot shot from the middle-right corner is not found 

on the tape, it means the optical path is very much 

misaligned. Try the middle-middle position instead of 

the middle-right position. Make sure the shots of the 

middle-left and the middle-middle overlaps then go back 

to the original middle-left and middle-right adjustment.
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6. The screws behind the second mirror control the 

mirror angle shown in the picture below. Release the 

nut on the screw, rotate the screw for the desired 

direction and test the shot position until the two 

shots overlaps. Tighten the nut back to its position 

when the adjustment is done.

 

 

          

Laser Head Displacement Adjustment

Goal: The dot on the metal ring be on the vertical center 

line of the ring. The dot must be above the center point of 

the ring.

1. Move the laser head to the center of the workarea 

Close the door and press "Laser Pulse".

2. Check if the dot landed on the vertical  

center line of the ring. If yes, skip to  

Step 6.

反射鏡 光點          second mirror     dot direction
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3. Release the 4 hex socket head screws with a 2.5mm 

Allen key.

4. Move the laser head forward or backward related to 

the rail. Then tighten the 4 screws back.

5. Press "Laser Pulse" and check if the dot landed on 

the vertical center line of the ring. If not, repeat the 

Step 3 and 4.

6. Check if the dot overlaps or is above the horizontal 

center line of the ring. If yes, move on to "Third 

Mirror Adjustment". 

 

 

 

        ▲ above center                           ▲ below center

  
7. If the dot is below the center line, adjust the screws 

of the laser tube holder. Release the holder on the 

laser beam outlet side and tighten the other side. 



67

8. Check if the dot is on or above the center line. The 

first and second mirrors will need adjustments if the 

position of the laser tube holder is widely adjusted.

Third Reflecting Mirror

Goal: Dot be made on the center of the laser beam outlet.

1. Remove the honeycomb plate to make room for 

adjustments.

2. Place a piece of tape on the laser head outlet. Apply 

pressure to the tape by hand so a circular mark can 

be seen. 

 

 

 

 

 

 

 

3. Move the laser head to the center of the workarea 

manually. Close the door and press "Laser Pulse".

4. Open the door and check if the dot is located near 

the center of the circle. If not, the screws behind the 

third mirror need to be adjusted.
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5. The screws behind the third mirror control the mirror 

angle which is shown in the picture below. Release 

the nust on the screws, rotate the screws for the 

desired direction until the two dots overlap. Tighten 

the nut back to its position when the adjustment is 

done. 

 

 

 

 

 

 

反射鏡 光點
    Third Mirror      Dot Direction
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The laser can now be distributed evenly to any spot of the 

workarea after the adjustments above. The performance 

should meet the needs of regular operation. Make sure 

you run "Camera Calibration" again. If the verticality of 

the optical path is required in specific applications, the 

steps below can be carried out for advanced adjustments.

Verticality of the Optical Path (Advanced)

Goal: Both dots on the lens holder and the laser beam 

outlet be on the center of the circle.

1. Move the laser head to the center of workarea 

manually. Place a piece of tape on the metal ring in 

front of the third reflecting mirror.

2. Close the door and press "Laser Pulse".

3. Open the door and measure the distance between 

the center of the dot and the center of the ring. Let 

the distance be X.
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4. Release three nuts behind the third mirror. Rotate the 

three screw equally so the mirror can move forward 

or backward in a paralleled direction. Make the gap 

between the metal pieces be "X" mm. 

 

 

 

 

 

 

 

5. Release the lens holder ring by rotating clockwise 

and lowering the lens holder to the mid-height. 

Fasten the holder by rotating the ring counter-

clockwise.

6. Place a piece of tape to the beam outlet.

7. Refer to the steps of "Third Reflecting Mirror" and 

readjust the screws behind the third mirror so the dot 

lands on the center of the circle.

8. Release and remove the whole lens holder. Place a 

piece of tape on the location shown in the picture 

below. Apply pressure to make a circular mark on the 

tape.
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9. Close the door and press "Laser Pulse". Open the 

door and check the dot. There are three scenarios:

• The shot is in the center of the circle. Indicating the 

optical path is already vertical.

• The dot is on the right side of the circle. Indicating 

the optical path comes from the top-right and exit 

to the bottom-left. Release each screws counter-

clockwise half-round to decrease the gap distance 

between the metal pieces. Redo Step 5 - 9.

• The dot is on the left side of the circle. Indicating 

the optical path comes from the top-left and exit 

to the bottom-right. Tighten each screws clockwise 

half-round to increase the gap distance between the 

metal pieces. Redo Step 5 - 9.

Make sure you run "Camera Calibration" again after the 

adjustment is done.
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6.6 LASER TUBE REPLACEMENT
 

Tools 

Accessory Kit: ① hex key ② little wrench  ⑧ funnel

Laser Tube Box: ⑥ hose plugs ⑦ cable ties 

Prepare On Your Own: ③ Philips screw ④ needle-nose pliers 

driver ⑤ diagonal pliers ⑨ towel ⑩ water container 

 

 

 

 

 

 

 

 

Unplug power before operation.

1. Remove the back lid by unscrewing the 6 star screws with 

the hex key in the Accessory Kit.  
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There are two ends on a laser tube. The one with the 

red wire which is closer to the touch screen is called the 

high-voltage side. The other next to the first mirror is 

called the low voltage side. 

 

 

 

                ▲ high-voltage                        ▲ low-voltage

2. Find the white connector on the high-voltage side. 

Twist open the connector and disconnect it. 

 

 

 

 

 

 

 

 

3. Find the white terminal near the low-voltage side. 

Press the button on the white terminal to release and 

remove the cable connected to the low voltage
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4. Remove the screws of the tube holder on both sides. 

 

 

 

 

 

 

5. Use pliers to move the hose clamp away from the 

laser tube.  
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6. Take the laser tube out of the chassis and place the 

low-voltage side above a container.   

 

 

 

 

 

 

 

 

 

 

7. Disconnect the hose from the tube and drain the 

water. Clog the hose by a plug when done. 
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8. Place a towel on the high-voltage side. 

 

 

 

 

 

 

 

 

9. Cut the cable tie on the end of the hose with 

diagonal pliers or scissors.  
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10. Pull off the hose and clog the end.  

 

 

 

 

 

 

 

 

Avoid spilling water into the machine. If it happens, 

wipe away the moisture and wait till the machine entirely 

dries up before operating.

11. The laser tube is now fully disconnected and can be 

entirely removed. 
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12. Place the new laser tube and connect the hoses on 

both ends.  

 

 

 

 

 

 

 

 

13. Zip the high-voltage end by a cable t ie and clamp 

the other end using the original metal hose clamp.

               ▲ Zip the high-voltage end by a cable tie
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            ▲ clamp the low-voltage end using the original 

     metal hose clamp

Release the metal clamp slowly to prevent the reaction 

force from damaging the laser tube.

14. Reconnect the white connector on the high-voltage 

side. Plug in the wire to the terminal on the low-

voltage side and make sure the wire get clamped 

firmly and does not fell off. Check if the wire is firmly 

clamped by the terminal. 
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     ▲ check if the wire is firmly clamped by the terminal

14. Place the tube into the chassis. Make sure there're 

gaps on both ends. The terminal on the tube  

connecting to the thick red wire should point inward. 

Install the screws of the tube holder clip and make 

sure the tube is fastened firmly.

Make sure the terminal of the red cable points inward 

instead of another angle. Do not let the end of the 

tube touch or close to the side of the chassis. Wrong 

placement for the tube may cause voltage leak. 
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15. Make sure everything is properly installed. Turn on  the 

machine when ready. 

Do not touch the area near the high voltage side on the 

tube to prevent electric shock. 

16. Press "Maintain" and the laser head will go to home 

position. Press "Pump" and the cooling water will be 

pumped into the laser tube. 

Beware not to press "Laser". Do not put finger near the 

laser beam outlet. 

17. Unplug power and open the cap of the water tank with 

the small wrench. Fill the tank with distilled water using 

the funnel and seal back the water tank. 
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▲ use the little wrench to open the tank

18. Repeat Step 11 and 12 until the level of the tank 

no longer goes down. Then the replacement is 

complete.
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7.1 NO LASER BEAM OUTPUT
 

If there is no laser beam output when beamo is running 

and it is making a loud cracking sound, it indicates the 

tube is broken. Please stop operating the machine to 

prevent further hardware failure. 

If you do not hear the cracking sound, please check the 

following:  

1. Go to touchscreen > Maintain, make sure the power 

is set to "x1.0" then close the door. Press “Laser 

Pulse” and observe from the laser observe window 

if a pinkish fluorescent light is emitted. If yes, it 

means the laser tube is functioning, please proceed 

to checking the optical path. If no pinkish fluorescent 

light is observed, please contact FLUX Support. 
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7.2 CUT DIDN'T GO THROUGH    
      MATERIAL

1. Go to touchscreen > Maintain, make sure the power 

is set to "x1.0". 

2. Check if the focus is adjusted at the right height. 

3. Check if the lens or mirrors are dirty or damaged.

4. Check if the optical path is aligned. 

5. If the solutions above didn’t work, please contact  

FLUX Support.

 

7.3 #900 COOLER OFF 

1. If you see a "#900 Cooler Off" dialog appears on the 

touchscreen, press "Continue". If the error message 

did not pop up again within one minute, the machine 

should operate normally. 

2. Check if the water level of the cooling tank is at least 

half full.
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7.4 #901 DOOR OPENED 
 
If the base is detached, install the base back first.

1. Go to touchscreen > Maintain, observe the icon on 

the top right corner. Check if the door icon is changed 

to “closed” when the front door is closed. If the icon is 

changed, the machine should operate normally. 

                      : Door opened                   : Door closed  

2. If the icon didn’t change, check if the door magnet fell 

off. 

 

 

 

 

 

3. If the magnet is still in place, open the back lid, take a 

magnet and place it over the sensor.   
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7.5 #902 OVERHEATED 

1. The room temperature should be 5- 35°C (41 - 95°F).

2. Go to touchscreen > Maintain, and check if the 

temperature is 5- 35°C (41 - 95°F).

3. If there is a huge difference between the room 

temperature and the temperature shown on the touch 

screen, please contact FLUX Support.

7.6 THE LASER HEAD DOESN’T RETURN  
      TO REAR LEFT CORNER

1. Gently move the laser head to the center of the bed.  

 

 

 

 

 

 

 

2. Go to touchscreen > Maintain, the laser head should 

first move to the top and then move to the rear left. 

3. If the laser head didn’t return to the rear left corner, 
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     please use your phone or camera to make a video   

     including the whole work area (like the image in Step 1).

4. Start filming and repeat Step 1 and 2, send the video 

to FLUX Support. 

7.7 CAMERA ALIGNMENT ISSUE 

1. Run camera calibration in Beam Studio > Menu > 

Machines > Choose Machine > Calibrate Camera. 

Make sure the focus is adjusted.

2. Compare the red-dotted-line square with the actual 

square engraved, manually adjust the values to make 

the 2 squares overlap.

7.8 CAMERA PREVIEW SPEED TOO SLOW 

The preview results are snapshots put together, if 

the loading speed is slow, try improving the internet 

connection.

1. Go to Beam Studio > Menu > Machines > Test Network 

Settings.

2. Fill in the Target device IP Address column with the 

machine IP address.
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3. Press Start and the test will start running. 

4. If the average response time is over 100ms, try 

reducing the distance between the machine and 

the router or mobile hotspot, or change to a wired 

connection.

7.9 CAMERA PREVIEW DOESN'T WORK 

If camera preview can’t be activated, try the following: 

1. Restart the machine and press "Maintain" and wait 

for the laser head to go to home position.

2. Move the laser head to the center of the bed. 

3. Press Snapshot, if the image is shown, it means the 

camera is functioning. Please refer to 7.8 Camera 

Preview Speed Is Too Slow.

4. If you see a question mark icon, it means the camera 

is not functioning. Please contact FLUX Support. 

7.10 CONNECTION ISSUE

No Wi-Fi Found

1. Make sure the Wi-Fi dongle is fully plugged in.

2. If there is no MAC Address of the wireless network 

on the touchscreen, please contact FLUX Support. 
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Unable to Connect When Selecting Wi-Fi

1. The Wi-Fi encryption mode should be WPA2 or no  

password.       

2. The encryption mode can be set in the Wi-Fi router 

administration interface. If the router doesn’t support 

WPA2 and you need help picking out the right router, 

please contact FLUX Support.  

Machine Doesn’t Appear In The Software 

1. Go to touchscreen > Settings > Internet and confirm 

the machine IP address. If the IP address starts with 

169.154, please see “IP Address Starts With 169.154” 

(p.94) 

2. Go to software Beam Studio > Menu > Beam Studio 

> Preferences, and fill out the Machine IP Address 

column. 

3. If the machine doesn’t appear, please see “Confirm 

Connection”.      

Confirm Connection

Make sure the machine IP address is shown and doesn’t 

start with 169.154.             
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1. Go to software Beam Studio > Menu > Machines > Test 

Network Settings  

 

 

 

 

 

 

 

 

 

2. Fill in the Target device IP Address column with the 

machine IP address.    
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3. Press Start and the test will start running. 

 

 

 

 

 

 

 

4. The statistics include Network Healthiness and Average 

Response Time. The Network Healthiness should be  

>95%, the Average Response Time should be <100ms. 

If the machine IP address is keyed in but the machine is 

still not found, please update the software to the latest 

version. If the connection issue persists, please contact 

FLUX Support.  
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IP Address Starts With 169.154

1. If the IP address starts with 169.154, it should be a 

DHCP setting issue, please contact your ISP (internet 

service provider) for further assistance.

2. If your computer connects to the internet directly using 

PPPoE, please change to using the router to connect 

using PPPoE, and enable DHCP feature in the router.

7.11 SOFTWARE QUITS UNEXPECTEDLY 

• Windows

Install Visual C++ Redistributable 2015, if the latest 

version is installed, download the latest Visual C++ 

Redistributable 2015 - 2019. If you are using Windows 

7, please update to Windows 7 SP1, install the latest 

graphics driver and Windows Update KB2670838.

• macOS

Update your OS to macOS 10.14 (Mojave) or above. 

Previous OS versions might have compatibility issues.

• Linux

Due to numerous types of systems, please provide the 

software log to FLUX Support.
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8.1 TECHNICAL DATA

Dimensions

W/D/H 615 x 445 x 177 mm (24.2 x 17.5 x 6.9 inches)

Weight 22 kg (48.5 pounds) 

Mechanics

Working area 300 x 210 x 45 mm (11.8 x 8.2 x 1.7 inches)

Camera HD CMOS

Laser

Power 30W

Wavelength 10640 nm

8.2 STORAGE & TRANSPORT 

Please keep the original packaging and upholstery.

• If your beamo remains unused for a short period of 

time, we recommend covering it to protect it from dust 

and other pollution.

• To store your beamo for a long period of time, it must 

be packed in its original packaging and not be exposed 

to high temperature and humidity fluctuations.

• beamo must be transported and shipped in its original 

packaging. beamo must not be thrown, knocked, 

shaken or subjected to any other mechanical loads.
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8.3 FLUX SUPPORT

If you need help resolving a problem, feel free to contact 

FLUX Support by email: support@flux3dp.com. Please read 

the user manual completely and install the latest software 

and firmware before contacting customer support.

8.4 DISASSEMBLING & DISMANTLING

beamo can be disposed of as a complete device. You 

do not have to disassemble or dismantle the unit before 

disposal. Only the cables and ventilation hoses can be 

handed over separately from your beamo to the electrical 

equipment collection unit. If disassembling or dismantling 

of the device is required, please contact FLUX support. 

As described in 1.3 Safety & Conformity, the user is not 

intended to disassemble beamo.

Disposal, environmental considerations

beamo may not be disposed of with household wastes in

accordance with local laws and regulations. Your beamo 

is an electronic device and must be disposed of in 

accordance with the Electrical and Electronic Equipment 

Waste Directive of your country at local electrical and 
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electronic equipment waste collection points. For further 

questions, please contact FLUX. 




